
 

 

L e s s o n  P l a n :  A e r o s o l s  &  I n f e c t i o n  

Background 
 
Aerosols are tiny particles or droplets suspended in a gas, such as air. There are millions of particles or droplets in the air 
we breathe. Aerosols are produced by naturally occurring processes such as rain, waterfalls, dust storms and volcanic 
eruptions. They can also be formed by human activities such as boiling water, opening a can of soda, turning on a water 
faucet, or taking a shower. Finally, people create aerosols when they cough, sneeze, talk, or even breathe – think about 
how you can “see your breath” in the winter when you go outside into the cold. This happens when you exhale and the 
small water droplets in your warm breath condense in the cold air, forming a cloud, or an aerosol. Because of the small 
size of water droplets or particles in aerosols, they float easily through air and follow the direction of air flow. The small 
droplets or particles in aerosols undergo diffusion – rapid back and forth movement –  at rates that we can estimate, but 
they travel through air by convection, the bulk movement or transport of substances in a fluid, like air. However, larger 
droplets or particles of greater mass will fall to the ground due to gravity. 
 
Aerosols can play an unintended role in spreading infections from bacteria and viruses that can cause you to get sick. In 
this lesson plan, we will demonstrate how viruses, such as the SARS-Cov-2 virus that causes COVID-19, can spread 
disease. Viruses are small particles that can float or move in air in aerosols. People become infected by breathing in virus 
which then make more copies of themselves inside cells of the infected person. After the virus has made many copies of 
itself by infecting and damaging many cells of the body, the infected person usually begins to show symptoms of the 
disease.  
 
Infected people can spread virus through sneezes, coughs and even talking. Virus is expelled from the infected person’s 
body in small water droplets that can float or move in air. These droplets can infect other people when they breathe 
them in, spreading the disease. The larger virus-containing droplets sink due to gravity and land on surfaces. The virus in 
these droplets can infect others when they touch the surface, transferring virus to their hands and then to their nose 
and mouth. 
 
Objectives & Grade Level 
Demonstrate how aerosols travel through air and estimate mass 
of droplets that fall down onto surfaces. Appropriate for middle 
school to high school science classes; see notes for advanced 
students. 
 

Materials  
• Water 
• Food coloring (e.g., McCormick Assorted Food Colors) 
• Atomizer, spray bottle or spritzer (Fig. 1)  
• White printer paper 
• Mask: Paper towel, Rubber bands (2) 

 

 

Fig. 1 Atomizer 

Atomizer (left); atomizer opening (right). 
 

0.25 in 
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Preparation of Materials  
Preparation of Colored Water (Experiments 1 and 2) 

1. Measure ¼ cup (~60 mL) of water into a container.  
2. Add 8 drops of food coloring to the water – we used Red for our experiments – and swirl to mix. Darker colored 

water is easier to detect in these experiments.  
3. Pour colored water into atomizer, spray bottle or spritzer. 

 
Face Mask (Experiment 2) 
We made a face mask from a paper towel for this experiment so we could determine the effect of the mask on 
preventing the transmission of the aerosol of colored water.  
 

1. Take a paper towel square and fold it into thirds (blue lines, Fig. 2A). 
2. Slide a rubber band onto each end of the folded paper towel (Fig. 2B), then fold the paper towel ends toward 

the center (Fig. 2C). 
3. Fit the mask over your nose and mouth, holding it in place by securing the rubber bands around your ears (Fig. 

2D, with permission). Now you have a mask!  
 

 

 

 

Procedure 
Experiment 1: Aerosol demonstration 

1. Place printer paper sheets flat on a table in front of the atomizer and have a friend or family member hold a 
sheet of paper vertical to the table (Fig. 3).  Make a note of the distance of the atomizer to the vertical paper. 

2. Using a cell phone camera, take a photo of each piece of paper to record the background before the experiment. 

Fig. 2 Face Mask 



 
 
 
 
 
L e s s o n  P l a n :  A e r o s o l s  &  I n f e c t i o n  P a g e  | 3 
 
 
 

 

3. Press down on the atomizer with as much pressure as it will allow, spraying the 
water across the table towards the vertical sheet of paper. 

4. Take a photo of the horizontal and vertical paper sheets after spraying to record the 
distribution of water droplets from the aerosol.  
 

a. What is the distribution of water droplets on the paper sheets? 

In our experiments, we observed many tiny spots on the vertical paper in an 
irregular, somewhat circular distribution (see Fig. 4, top left). The distribution can 
differ using a different atomizer. 

b. Are the distributions different for the horizontal paper sheets, compared to the 
vertical paper?  

Yes! We observed a large area of small spots on the vertical paper and many fewer 
spots on the horizontal paper (Fig. 4, top right).  

5. Now spray the colored water from two different distances away from the vertical paper and observe what 
happens to the distribution of spots. For example, try spraying the atomizer from 3 inches and 9 inches away 
from the vertical paper.   

a. How does the aerosolized droplet distribution change when you 
move the atomizer farther away from the vertical paper? 

The distribution of spots on the vertical paper becomes larger when the 
atomizer is farther away (Fig. 4, bottom left). This occurs because the 
forward movement of the droplets slows due to air resistance and the 
droplets begin to fall due to gravity; the droplets can also diffuse in air 
before they land on the vertical paper (see Notes). The horizontal paper 
sheet shows a larger distribution of spots because more droplets fall 
because of the slowing down of their forward velocity and the effects of 
gravity (Fig. 4, bottom right).  

b. What do you think would happen if we changed the size of the 
hole in the water atomizer? Or, if we changed the pressure used to 
create the aerosol? 

If there is a larger hole, the size of the droplets produced by the 
atomizer would be larger and more of the droplets would fall onto the 
horizontal paper. If we spray with lower pressure, the droplets would 
again be larger and would not travel as far, increasing the distribution 
of spots on the horizontal paper. 

 
 

Experiment 2: Aerosol with mask  
1. For safety, remove the paper towel mask from your face for the experiment. 

 

2. Have a friend or family member hold a sheet of paper vertical to a table (see Fig. 3) and take a photo for a 

Fig. 3 

Fig. 4   
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background control, then have him/her hold the mask against the paper with the outside facing out (outside 
refers to the side that would not touch your face if you were wearing the mask).  

 

3. Spray the colored water onto the mask and vertical paper from a distance of 3 inches. Remove the mask and 
take a photo of the paper to see how many of the aerosolized colored droplets went through the mask. 

 

a. Are there more or fewer spots on the 
paper that was covered by the mask 
than the region without the mask? 
What about the paper covered by the 
mask compared to the vertical paper 
sprayed from 3 inches in Experiment 
1? How can you explain this?  

There are fewer spots on the vertical 
paper that was protected by the mask 
than the vertical paper in Experiment 
1 (Fig. 4) because the mask absorbed 
the aerosolized droplets so that they 
did not go through onto the paper. If 
the droplets had contained virus and 
you were wearing the mask, the virus 
would not have gone through the 
mask and would not be breathed in. 

 

Quantitation of Aerosol Droplets on Paper Sheets 
Procedures  

=  We used the program FIJI (available at https://fiji.sc) to measure the aerosol droplets that landed on the paper 
sheets.  After opening photos of the paper sheets in FIJI, we changed the photos with red colored spots to 8-bit 
grayscale images to standardize the measurements. We then measured the grayscale values of the paper sheets 
before and after spraying: 
1. Go to File > Open and select the photo to open 
2. Go to > Image > Type > 8-bit to change the photo from RGB to 8-bit grayscale. 
3. Go to Analyze > Set Measurements, select Area, Min & max gray value and Mean gray value, set decimal places 

to 0, and click OK. 
4. Select the rectangle (box) tool on the toolbar and draw a box on the image. Go to Analyze > Measure. Results for 

Area, Mean, Min and Max grayscale values of the boxed region will appear in a new window. 
 

=  For an 8-bit image, the shade of gray of each picture element or pixel that makes up the image is given by an 8-
place number consisting of 0’s and 1’s. Since each position in the 8-place number can be either 0 or 1, there are 28 = 
256 different shades of gray. The smallest and largest numbers, 0000000 and 11111111, are assigned as black or 
white.  

 

Fig. 5   

Spray 3 inch  Under Mask 3 inch 
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=  For quantitation of our aerosol experiments, we first measured images consisting 
of blocks of single colors (white, pink, red, black) after converting the images to 8-bit, 
to determine their grayscale values. The measurements in FIJI gave Black=0 (or 
00000000 for an 8-bit image) and White=255 (or 11111111 for an 8-bit image) with 
Red=111 and Pink=234 (Fig. 6). This means that lighter colors such as White and Pink 
have higher grayscale values in FIJI than darker colors such as Black and Red. That is, 
the grayscale values for the sprayed papers will decrease with greater numbers of red 
droplets that have landed and formed spots.  

 

=  We then measured the minimum, maximum and mean grayscale values of the 
papers from our experiments before and after spraying. Since the minimum grayscale values correspond to the 
darkest red spots on each paper, we used the minimum (Min) grayscale values for each paper as a measure of the 
largest number of droplets that had landed on the paper.  We compared the Min values before and after spraying the 
aerosol to make certain that the paper itself was not giving low grayscale values. We used the same methods to 
determine the effect of the mask in protecting the paper from the dye spots.  

 
Measurements  
For each trial, we measured the entire blank page before spraying (background before spraying), together with the 
largest area possible for the region of the paper without droplets after spraying (background after spraying) and the 
region of the paper on which the droplets had landed after spraying, excluding lines and writing on the paper. We then 
calculated the average Min grayscale values and experimental error (standard error of the mean, SEM; standard 
deviation, SD; see BASICS: Lesson Plan on Experimental Error). Because the SEMs for the two backgrounds (before and 
after spraying) were overlapping or close to one another for the 3 inch (n=3) and 9 inch (n=3) experiments, we 
calculated a single average background for each set of experiments. For consistency, we also calculated a single 
background for the mask experiment, although the background before spraying (104±2.19, mean±SEM, n=3) was 
significantly different from the background after spraying (143±16.8, n=3), probably because of differences in 
experimental conditions, e.g., room lighting when the background control photos and photos after spraying were taken.  
 

The plots and photos of the aerosol experiments show that there were more aerosol droplets on the 3 inch vertical 
papers than the horizontal papers, while the 9 inch experiments showed approximately the same distribution of spots 
on the vertical and horizontal papers, differing significantly from the 3 inch experiments (Fig. 4 & Fig. 7, gray bars). 
 
  
 
 
 
 
 
 
 
 
 

Fig. 6 

Fig. 7   Fig. 8   
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The mask experiment shows that the sprayed mask has droplets on the outside, but that the region of the 
 paper covered by the mask was protected from the aerosol droplets (Fig. 5 & Fig. 8, gray bars). This experiment 
demonstrates that the mask is an effective way to block the aerosolized droplets from landing on the paper. 
 
Conclusions 
 

These experiments show that 1) the distribution of aerosolized droplets changes depending on the distance from the 
aerosol source. When we moved the atomizer farther away from the vertical paper, the distribution of the droplets was 
broader (Fig. 4). 2) The droplets that fell due to gravity and landed on the horizontal paper increased in the 9 inch spray 
experiments compared to the 3 inch experiments (Fig. 4 & Fig. 7). There were no visible spots on the horizontal paper 
sheets after the atomizer had been sprayed at 3 inches, but there were many spots after the atomizer had been sprayed 
at 9 inches. Because of the greater distance the droplets had to travel, more of them fell before reaching the vertical 
paper. 3) No aerosol droplets went through our paper towel mask onto the vertical paper, although the droplets landed 
on places that the mask did not cover (Fig. 5 & Fig. 8).  
 

These experiments help us understand how to limit the spread of viruses such as SARS-CoV-2, which causes COVID-19. 
First, aerosols containing virus that are produced by coughs or sneezes of infected persons will spread out and become 
more diffuse with increased distance to another person (Bromage, 2020). Second, masks can greatly reduce the virus-
containing aerosol droplets that come into contact with a person, which can enter the body through the nose and 
mouth. Since these two areas are otherwise unprotected against the virus, it is very important to prevent the spread of 
viral infection by wearing a mask (Prather et al., 2020). Medical masks, cotton masks and even the paper towel masks 
used in our experiments will help reduce the spread of the virus. Thus, keeping other potentially infected persons at a 
distance and wearing a mask are two effective ways of preventing the spread of viral infections such as COVID-19. 
 
Notes 
 

The water droplets in our aerosols are propelled forward from the atomizer opening because of the force we used to 
create the aerosol by pressing down on the atomizer top. The droplets slow down because of air resistance and fall 
because of gravity. The droplets can also diffuse in air before landing on the horizontal or vertical paper sheets. We 
estimated diffusion rates of the droplets in air and the size of the droplets that fall due to gravity, as shown below. 
 
Advanced topic 1 The Stokes-Einstein diffusion equation models particle diffusion in a given medium. We used the 
Stokes-Einstein equation to calculate a diffusion coefficient for the aerosolized droplets to estimate how rapidly the 
droplets diffuse in air. The equation is given as follows: 

𝐷 =
𝑘𝑇
6𝜋𝜂𝑅

 
 

D, Diffusion coefficient of droplets ()*
+

,
) 

k, Boltzman constant, 1.38065 × 10456 	8∗)*
+

:∗,+
 

T, absolute temperature (K) 
η, solvent viscosity ( 8

)*∗,
) 

R, hydrodynamic radius of droplets (cm) 
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The temperature at which our experiments were performed is T= 25ºC=~298ºK. Viscosity, η= ~1.81× 104; 8
)*∗,

 , for air 

at 25ºC. Using these values, we determined the relationship between the diffusion coefficient and the hydrodynamic 
radius of the droplets in the aerosol as follows: 
 

𝐷 =
1.38065 × 10456 × 298	
6	𝜋 × 1.81 × 104; × 𝑅

=
4.1144 × 1045;

1.09 × 104?	 × 𝜋	𝑅
 

 
We assumed that the droplets in the aerosol in each experiment are smaller than the smallest droplets that fell onto the 
horizontal paper. We estimated the hydrodynamic radius, R, of the smallest droplets sprayed by the atomizer at 9 inches 
from the vertical paper by measuring the diameter of the smallest spots on the horizontal paper and dividing by 2 to find 
the radius. The average radius of the smallest spots was 0.0833±0.0258 mm (mean±SD, n=6). We hypothesized that the 
spots on the paper corresponded to flattened spherical droplets with an area related to the volume of the original 
droplets. To determine the relationship between the spot area and original droplet volume, we made spots of colored 
water of different volumes (2, 4, 8 µl) on the same paper as we used in the aerosol spray experiments and measured the 
spot diameter, then we calculated the spot radius and area. By plotting the spot area vs drop volume, we found that the 
area of the spots, A (cm2), was proportional to 0.036337 x the volume, V (µl), of the original drops. From the average 
radius above of the smallest spots, 0.0833±0.0258 mm, we calculated the area of the smallest spots, A=p r2=p (0.00833 
cm)2=0.000218 cm2 and divided by 0.036337 to find the volume of the original droplets, V=0.00600 µl = 0.00600 x 10-3 
cm3. Assuming the droplets are spheres, V=4/3 p r3= 0.00600 x 10-3 cm3 and r=0.0113 cm. We used this value of r for the 
hydrodynamic radius of the smallest droplets that landed on the vertical paper in our 9 inch aerosol spray experiment, 
R=0.0113 cm. We assumed that droplets smaller than this remained suspended in air and could diffuse in air as aerosols, 
and that the hydrodynamic radius of these droplets in aerosols is R < 0.0113 cm. 
 
The diffusion coefficient, D, for the aerosol droplets that remain suspended in air and diffuse is given by the following 
inequality, which accounts for values of R < 0.0113 cm and is consistent with increased D as droplet size decreases:  
 

𝐷 >
4.1144 × 1045;

1.09 × 104?	 × 	0.0113	𝜋
 

 
𝐷 > 1.06 × 104A 

 
Does the radius of the smallest spots on the vertical paper change depending on the distance at which you 
sprayed the aerosol?  
 

How does increasing the spraying distance from the vertical paper change the value of D for the droplets that are 
smaller than the smallest droplets that landed on the paper? 

 
NB: The value of D may differ with your atomizer in your experiments compared to ours. 
 
The calculation above gives the diffusion coefficient, D, for the droplets that remained suspended in air as aerosols and 
diffuse. These droplets consist of a wide range of sizes that are smaller than the smallest droplets of average radius, 
r=0.0113 cm, that fell onto the paper. To estimate the distance that the aerosol droplets diffuse, we calculated the 
diffusion coefficient, D, for droplets that were 10 times, 100 times and 1000 times smaller in size than the smallest 

cm2/s 

cm2/s 

cm2/s 
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droplets that fell onto the horizontal paper. Note that D increases as droplet size decreases.  We obtained the following 
values for D: 
 
Droplets 10x smaller          R=0.00113 mm  D=1.06 × 104B cm2/s 
Droplets 100x smaller          R=0.000113 mm  D=1.06 × 104C cm2/s 
Droplets 1000x smaller          R=0.0000113 mm   D=1.06 × 1046 cm2/s 
 
The distance that the droplets of different sizes travel in air by diffusion can be estimated using the Einstein-
Smoluchowski diffusion equation. For our estimates, we use the derivation for 3D diffusion (Berg 1983): 
 

𝑥E = 6𝐷𝑡 
 

x, distance (cm) 
D, diffusion coefficient (cm2/s) 
t, time (s) 

 
For our estimates, we calculated the distance traveled in 10 min=600 s by the droplets that remain suspended in air: 
 
Droplets 10x smaller:                                      	𝑥E = 6(1.06 × 104B)(600) cm2 

𝑥 = 6.18	 × 104?	𝑐𝑚	 
 
Droplets 100x smaller:                                    	𝑥E = 6(1.06 × 104C)(600) cm2 

𝑥 = 1.95	 × 104E	𝑐𝑚	 
 
Droplets 1000x smaller:                                  	𝑥E = 6(1.06 × 1046)(600) cm2 

𝑥 = 6.18	 × 104E	𝑐𝑚	 
 
The distances traveled by the droplets by diffusion in 10 min are very small, less than a cm. Even the droplets that are 
1000x smaller than the smallest droplets that fell onto the horizontal paper travel much less than 1 cm in 10 min by 
diffusion. This means that the droplets in the aerosol spread out due to diffusion, but diffusion in air does not contribute 
significantly to the distance traveled by the droplets before they land on the vertical paper. Instead, the air currents 
created by the atomizer when the droplets are produced cause the droplets in the aerosol to travel through the air by 
convection.  
 
Advanced topic 2 We calculated how large a droplet must be to fall due to gravity in our experiments and how quickly 
the droplets fall. The droplets fall because they are heavier than air resistance. We assumed that droplets fall if they are 
equal to or greater in mass than the smallest droplets that fell onto the horizontal sheet of paper. 
 
Newton’s Second Law of Motion states that force acting on an object results in acceleration that is dependent on the 
mass of the object. For objects falling due to gravity, this is given by the equation: 
 

𝐹8 = 𝑚𝑔 
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Fg, Force of gravity (N) 
m, mass of the object (kg) 
g, acceleration of gravity= 9.8 m/s2 

 
A droplet in our experiments has a mass sufficient to fall when Fg is equal to air resistance, or drag. The equation 
modeling drag is as follows: 
 

𝐹M =
1
2
𝐶M𝑉E𝜌𝐴 

 
Fd, Force of drag (N) 
Cd, Drag coefficient  
V, velocity of droplet (m/s) 
ρ, density of air (kg/m3) 
A, cross sectional area of droplet (m2) 

 
We assumed that the droplets produced by our atomizer are spherical. This allowed us to let Cd = 0.47 for a spherical 
object. The density of air is ~1.2 kg/m3. The cross-sectional area of the droplet can be approximated using the formula 
for a circle, A=𝜋𝑟E. We used our corrected estimate of r=0.0113 cm for the radius of the smallest spots on the horizontal 
paper in our 9 inch aerosol experiment, as described above in Advanced topic 1. The velocity of the droplets that fell 
onto the horizontal paper can be estimated from acceleration of gravity and time by measuring the height of the hole in 
the atomizer. This height, h= ½ gt2, where t is the time required for droplets to land on the horizontal paper. For our 
atomizer, h=11.561±0.0111 cm (mean±SD, n=6; Fig. 1). After solving for t=0.154 s, we estimated the velocity of the 
smallest droplets that fell onto the horizontal paper from V=gt=1.51 m/s. 
 
 The mass of the smallest droplets that fell onto the horizontal paper is then given by  

𝑚𝑔 = 	5
E
× .47 × (𝑔𝑡)E × 1.2 × 𝜋𝑟E  kg m/s2 

 
We solved for m=2.63 x 10-9 kg=2.63 µg. Droplets that are equal to or greater in mass will fall and land on the paper due 
to gravity and those of smaller mass will remain suspended in air as an aerosol.  
 
Note that our estimates of the smallest drops that fell are limited by our measurements of the smallest spot diameters 
on the paper, which were measured with a centimeter ruler marked in mm using a small magnifying lens; a cell phone 
camera can be used to magnify the spots on the paper for greater accuracy. 
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